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Welcome 

 

Welcome to your iiNet BizPhone service! 

 
Inside this guide you will find information on how to use and configure the features and services on 
offer. If you have any issues using your BizPhone service, please give our friendly Business Support 
Team a call on 13 86 89 and we’ll be happy to help. 
 
This guide covers both BizPhone Handset User plans (including Standard, Cordless, Premium and 
SoftPhone plans) as well as BizPhone Line (ATA) plans. 
 
As our product will continue to be upgraded with enhancements and new features, please ensure 
you check the online version of this guide at your BizPhone Online Portal 
(https://www.iihelp.iinet.net.au/BizPhone_Support_Resources) to get the most up-to-date 
information. 
 
You can also find How To video guides for a range of core BizPhone features at 
http://www.bizphone.net.au/howtovideos. 

https://www.iihelp.iinet.net.au/BizPhone_Support_Resources
http://www.bizphone.net.au/howtovideos
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BizPhone Frontier Feature Configuration 
 
iiNet BizPhone has many configurable features allowing you to customise your phone to suit you 
best. 
 
BizPhone Administrator 
The Administrator will have access to the Frontier Admin portal to set or modify the BizPhone 
phone system and end user configuration options, such as: 

• Group Level configuration options 

• Configuration of any existing phone/user settings (Call Forward, Do Not Disturb, etc) 
 
The username and password for the Administrator account is emailed to your account contact 
along with the Service Completion Advice. 
 
Log in to the Portal 
To log in to the BizPhone Frontier Admin portal go to https://frontier.iinet.net.au/s/login via your 
web browser, where the following will be displayed: 
 

 
 

Enter the BizPhone Admin’s username and password. 
 

 
  

https://frontier.iinet.net.au/s/login
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BizPhone Frontier Admin Portal 
Once you log in to the Frontier portal, the below page (Main page) will appear. 

 

 
 
For details on how to use and configure each of the BizPhone features, please refer to the relevant 
sections of this document. 
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Basic User Features 
 
The Basic User Features (per user) are available across all handsets. They are configurable from the 
Frontier Admin portal. Alternatively, some of these features are configurable via the user handsets 
as well. 
 
To access the Basic User Features, go to the users section under BizPhone Admin (bottom part of 
the screen) and click on the  icon for each user that you wish to configure.  
 
For example, in the below screen there are 4 users that you can configure. 
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Once you click the  icon next to the BizPhone user, the Basic User Features page below will 
appear (for BizPhone Handset Users). 
 

 
 
 
 
 
 
If the user has a BizPhone Line (ATA) plan, the below Basic User Features page will appear. It has 
fewer menu items (Features) compared to a BizPhone Handset User. 
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Notes: 

- The extension of the user is the last 5 digits of their full geographical phone number. For 
any extension starting with “000”, the system will automatically replace the first or the 
leading digit of the extension with “1”. For example, if the extension is 000xx, it will 
become 100xx. For internal use, users need to ring 100xx to reach the users. 

- The phone number of each user is displayed next to the Service details of the Basic User 
Features page. 

 
 

To return to the main page without changes, click on the  icon located at the top right of each 
BizPhone User page. 
 

To configure each of the Basic User Features, refer to the relevant sections. 
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Call Forward No Answer 
Call Forward No Answer forwards incoming calls to a particular phone number if the user does not 
answer the call in a specific time period. The user can also forward calls to their Voice Mail if they 
wish. 
 
Note: If Call Waiting is on and a call is waiting, it will be redirected after that time period. 
 
How do you use it? 
By changing the user’s settings in Frontier, your preference will then be applied to all 
future calls. 
 
Default setting: Off 
 

How to set in Frontier:  

• Change the status next to Call Forward “No Answer” to active by clicking on 

 or inactive by clicking on . If the status is set to active, you need to 
enter a valid 10-digit phone or mobile number to forward all calls to. 
Alternatively, you can also forward calls to the Voice Mail by entering *55 in 
front of the 10-digit phone number or in front of the extension. 
The system default number of rings before a call is forward to a voice mail is 3 
rings (18-20 seconds). 

• Click “Update” at the bottom of the screen to save the changes. 
 
How to override on handset: 

• To de-activate the Call Forward No Answer feature, lift the handset and dial 
*93. 
Or you can also use the handset menu to de-activate this feature:  
DECT Handset: OK -> Call Features -> Call Forward -> OK -> Disabled -> Save. 
Other Handsets: Menu -> Call Control -> Call Forward -> No Answer -> Disabled -> Save. 
 

• To activate, lift the handset and dial *92 and enter the phone number to 
forward the calls to. 
Or you can also use the handset menu to activate this feature: 
DECT Handset: OK -> Call Features -> Call Forward -> OK -> Enabled (enter the number to 
forward calls to under Target) -> Save. 
Other Handsets: Menu -> Call Control -> Call Forward -> No Answer -> Enabled (enter the 
number to forward calls to) -> Save. 

 

Call Forward Busy 
Call Forward Busy forwards incoming calls to a particular phone number if the user is on a call. The 
user can also forward the calls to their Voice Mail if they wish. 
 
Note: Call Waiting override Call Forward Busy. 
 
How do you use it? 
By changing the user’s settings in Frontier, your preference will then be applied to all 
future calls. 
 
Default setting: Off 
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How to set in Frontier:  

• Change the status next to Call Forward ”Busy” to active by clicking on  or 

inactive by clicking on . If the status is set to active, you need to enter a 
valid 10-digit phone or mobile number to forward all calls to. 
Alternatively, you can also forward calls to the Voice Mail by entering *55 in 
front of the 10-digit phone number or in front of the extension. 
The system default number of rings before a call is forwarded to a voice mail is 
3 rings (18-20 seconds). 

• Click “Update” at the bottom of the screen to save the changes. 
 
How to override on handset: 

• To de-activate the Call Forward Busy feature, lift the handset and dial *91. 
Or you can also use the handset menu to de-activate this feature:  
DECT Handset: OK → Call Features → Call Forward → OK → Disabled → Save. 
Other Handsets: Menu → Call Control → Call Forward → Busy → Disabled → Save. 

• To activate, lift the handset and dial *90 and enter the phone number to 
forward the calls to. 
Or you can also use the handset menu to activate this feature: 
DECT Handset: OK → Call Features → Call Forward → OK → Enabled (enter the number to 
forward calls to under Target) -> Save. 
Other Handsets: Menu → Call Control → Call Forward -> Busy → Enabled (enter the number 
to forward calls to) → Save. 

 

 

Call Forward Immediate (Always) 
Call Forward Immediate forwards all incoming calls to a particular phone number. The user can also 
forward the calls to their Voice Mail if they wish. 
 
How do you use it? 
By changing the user’s setting in Frontier, your preference will then be applied to all 
future calls. 
 
Default setting: Off 
 

How to set in Frontier:  

• Change the status next to Call Forward “Immediate” to active by clicking on  

or inactive by clicking on . If the status is set to active, you need to enter a 
valid 10-digit phone or mobile number to forward all calls to. 
Alternatively, you can also forward calls to the Voice Mail by entering *55 in 
front of the 10-digit phone number or in front of the extension. 
The system default number of rings before a call is forwarded to a voice mail is 
3 rings (18-20 seconds). 

• Click “Update” at the bottom of the screen to save the changes. 

 
How to override on handset: 

• To de-activate the Call Forward Immediate feature, lift the handset and dial *73.  
Or you can also use the handset menu to de-activate this feature:  
DECT Handset: OK → Call Features → Call Forward → OK → Disabled → Save. 
Other Handsets: Menu → Call Control → Call Forward → Always → Disabled -> Save. 
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• To activate, lift the handset and dial *72 and enter the phone number to forward all calls to. 
Or you can also use the handset menu to activate this feature: 
DECT Handset: OK → Call Features → Call Forward → OK → Enabled (enter the number to 
forward calls to under Target) → Save. 
Other Handsets: Menu → Call Control → Call Forward → Always → Enabled (enter the 
number to forward calls to) → Save. 
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Call Forward Not Reachable 
Call Forward Not Reachable forwards all calls to a different phone number when the user handset is 
not accessible. The user can also forward the calls to their Voice Mail if they wish. 
 
How do you use it? 
By changing the user’s settings in Frontier, your preference will then be applied to all 
future calls. 
 
Default setting: Off 
 

How to set in Frontier:  

• Change the status next to Call Forward “Not Reachable” to active by clicking on 

 or inactive by clicking on . If the status is set to active, you need to 
enter a valid 10-digit phone or mobile number to forward all calls to. 
Alternatively, you can also forward calls to the Voice Mail by entering *55 in 
front of the 10-digit phone number or in front of the extension. 
The system default number of rings before a call is forwarded to a voice mail is 
3 rings (18-20 seconds). 

• Click “Update” at the bottom of the screen to save the changes. 
 
How to override on handset: 

• To de-activate the Call Forward Not Reachable feature, lift the handset and dial 
*95. 

• To activate, lift the handset and dial *94 and enter the phone number to 
forward the calls to. 

 
 

Call Waiting 
Call Waiting is a service that allows the user to be alerted to an incoming call by a faint beep or click 
when the user is already talking on the phone. This gives the user the ability to either take that call 
by putting the first call on hold or just continue with the conversation that they are currently 
having. 
 
How do you use it? 
To use Call Waiting, you must already be on a call. 
 
DECT Handset: When a second call comes through, it will appear on the phone screen. Press 
“Accept” to speak to the second caller without hanging up the first caller (the first caller will be put 
on hold). 
To resume the held call, press “Swap”. 
 
T42G (T42S) Handset: When a second call comes through, press the down arrow button and the 
answer option will be shown on the LCD screen. You can then press “Answer” to speak to the 
second caller without hanging up the first caller (the first caller will be put on hold). 
To resume the held call, press the up arrow button and press “Resume”. 
 
T48G (T48S) Handset: When a second call comes through, you will see incoming call on the LCD 
screen. Click on the incoming call and click “Answer” to speak to the second caller without hanging 
up the first caller (the first caller will be put on hold). 
To resume the held call, click the hold call and click “Resume”. 
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Default Setting: On 
 
How to set in Frontier: 

• Change the status next to Call Waiting to active by clicking on  or inactive by 

clicking on . 

• Click “Update” at the bottom of the screen to save the changes. 
 
How to override on handset: 
To disable the call waiting, lift the handset and dial #43.  
Or you can also use the handset menu to de-activate or activate this feature:  
DECT Handset: OK → Call Features → Call Waiting → “Disabled” (to de-activate) or “Enabled” (to 
activate) → Save. 
Other Handsets: Menu → Features → Call Waiting → “Disabled” (to de-activate) or “Enabled” (to 
activate) → Save. 
 
 

3-Way Conference Call 
3-Way Conference Call enables a user to bring a third party into an existing conversation, and allows 
the three parties to listen and talk to each other. 
 
How do you use it? 
To use the 3-Way Conference Call, you must start on a connected call.  
 
DECT Handset: When you are connected in a call, press “Options” and then select “Conference” key 
on the phone and then enter the number of the third party you wish to conference in. Once the call 
is answered, press the “Conf” key again to join the parties together. 
 
Other Handsets: Press the “Conf” or “Conference” key on the phone, and then enter the number of 
the third party you wish to conference in. Once they answer the call you can speak to them 
privately, and then press the “Conf” or “Conference” key again to join all parties together. 
 
Note: If either of the two parties hand up during the call, the call with the other party remains 
connected. It the user hangs up, the other two parties will be disconnected. 
 
Default Setting: On (Not configurable) 
 
 

Call Transfer 
Call Transfer allows a user to transfer a connected call to a third party (either internal or any phone 
number). 
 
There are two types of transfer: Blind Transfer and Attended Transfer (not available on the DECT 
handsets). 
 
An attended transfer allows the user to speak to the third party privately before transferring the call 
across. 
A blind transfer simply redirects the call to the third party and the hangs up the user. 
 
How do you use it? 
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To use Call Transfer, you must start on a connected call.  
 
DECT Handset: To transfer a call, press “Options” and select “Transfer” key on the phone. Then 
enter the phone number that you wish to transfer the call to and press the “Transfer” key again. 
The call will then be transferred to a third party. 
 
Other Handsets: To transfer a received call, press the “Trans” or “Transfer” button on the phone. 
The existing call will be placed on hold, and you will have two options: 

1. If you want to make an “Attended” transfer, dial the third party number, speak to the third 
party, and press the “Transfer” button again. 

2. If you want to make a “Blind” transfer, dial the third party number and press the “Transfer” 
button and the call should transfer immediately. 

 
Default Setting: On (Not configurable) 
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Calling Number Display – Incoming 
Calling Number Display – Incoming allows the user to display or hide the other party’s phone 
number when they are calling the user. 
 
Default Setting: On 
 
How to set in Frontier: 

• Change the status next to Calling Number Display – Incoming (Caller Number 

Display) to active by clicking on  or inactive by clicking on . 

• Click “Update” at the bottom of the screen to save the changes. 

 
 

Calling Number Display – Outgoing 
Calling Number Display allows the user to display or hide their phone number when making an 
outbound call.  
 
Default Setting: On 
 
How to set in Frontier:  

• Change the status next to Calling Number Display – Outgoing (Caller Line 

Identifier) to active by clicking on  or inactive by clicking on . 

• Click “Update” at the bottom of the screen to save the changes. 
 
How to override on handset: 

• To de-activate, lift the handset and dial *31 and then the user phone number 
will be restricted to the other party. 

• To activate the Calling Number Display - Outgoing, lift the handset and dial #31. 
 

Override External CLI 
Override External CLI allows the user to override their Calling Number Display for outgoing external 
calls with a different phone number than his/her own or the pilot number. Note that the override 
number can only be another active BizPhone number. 
 
Below are examples to show situations where this feature may be useful: 

• An external CLI to be configured on a customer department level (e.g. Finance, HR) or 
location/store. 

• An external CLI to be configured for users in Hunt Group only, so when the users in the 
group return a missed call or make outgoing external calls, the Hunt Group number will 
appear as their external CLI. 

• A specific user(s) to be exempted from the pilot number. For example, the company director 
may not want to display the pilot number as their external CLI. 

 
Default Setting: Off 
How to set in Frontier: 

• Change the status next to Override External CLI to active by clicking on  or inactive by 

clicking on  . 

• Select a phone number from the drop down list. This number will then be displayed as the 
CLI when the suer makes an outgoing external call. 

• Click “Update” at the bottom of the screen to save the changes. 
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Call Barring 
Call Barring bars certain types of calls (Mobile, International, and Long Distance) from 
being made from the user’s phone. 
 
Default Setting: Off 
 
How to set in Frontier: 

• Change the status next to the Barring “Mobile” or “International” or “Long 

Distance” to active by clicking on  or inactive by clicking on . 

• Click “Update” at the bottom of the screen to save the changes. 
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Anonymous Call Rejection 
Anonymous Call Rejection allows a user to reject incoming calls that do not have Caller ID Display 
enabled. By enabling the service, a caller who has their caller ID blocked will have their incoming 
call rejected. The caller will hear a message informing them that the user is not accepting 
anonymous call at this time. The user’s phone will not ring and the user will not see any indication 
of the call. 
 
Note: Anonymous Call Rejection is not available on BizPhone Line (ATA) plan. 

 
How do you use it? 
By changing the user’s settings in Frontier, your preference will then be applied to all 
future calls. 
 
Default setting: Off 
 
How to set in Frontier: 

• Change the status next to Anonymous Call Rejection to active by clicking on 

 or inactive by clicking on . 

• Click “Update” at the bottom of the screen to save the changes. 
 
How to override on handset: 

• To Activate the Anonymous Call Rejection feature, lift the handset and dial *77. 

• To de-activate, lift the handset and dial *87. 
 
Or you can also use the handset menu to activate or de-activate or activate this feature:  
DECT Handset: OK → Call Features → Anon. Call Rejection → OK → “Disabled” (to de-
activate) or “Enabled” (to activate) → OK. 
Other Handsets: Menu → Call Control → Anonymous Call Rejection → “Off” (to de-activate) 
or “On” (to activate) → Save 
 
 

Automatic Call Back 
Automatic Call Back allows the user who receive a busy tone to monitor the busy party and 
automatically establish a call when the busy party becomes available. 
 
Note: Automatic Call Back is not available on BizPhone Line (ATA) plan. 
 
 
How do you use it? 
By changing the user’s setting in Frontier, your preference will then be applied to all 
future calls. This feature can only be activated when calling within the same group. 
 
Default setting: Off 
 
How to set in Frontier: 

• Change the status next to Automatic Call Back to active by clicking on  or 

inactive by clicking on . 

• Click “Update” at the bottom of the screen to save the changes. 
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Do Not Disturb 
Do Not Disturb allows the users to set their phone as unavailable so that incoming calls are 
treated as if the user is busy. 
 
Note: Do Not Disturb is not available on BizPhone Line (ATA) plan. 
 
How do you use it? 
By changing the user’s settings in Frontier, your preference will then be applied to all future calls. 
 
Default setting: Off 
 
How to set in Frontier: 

• Change the status next to Do Not Disturb to active by clicking on  or inactive 

by clicking on . 

• Click “Update” at the bottom of the screen to save the changes. 
 
How to override on handset: 

• To Activate the Do Not Disturb feature, lift the handset and dial *78 or press the 
“DND” key on the phone (not available for DECT handsets). 

• To de-activate, lift the handset and dial *79. 
 

Do Not Disturb Reminder 
Do Not Disturb Reminder plays ring reminder when the call is blocked. 
 
Note: Do Not Disturb Reminder is not available on BizPhone Line (ATA) plan. 
 
How do you use it? 
By changing the user’s settings in Frontier, your preference will then be applied for future calls. 
 
Default setting: Off 
 
How to set in Frontier: 

• Change the status next to Do Not Disturb Reminder to active by clicking on  

or inactive by clicking on . 

• Click “Update” at the bottom of the screen to save the changes. 
 

Remote Office 
Remote Office allows user to access and use their BizPhone service from any phone number 
(home office, mobile phone) that you specified as your Remote Office.  
 
Note: Remote Office is not available on BizPhone Line (ATA) plan. 
 
How do you use it? 
By changing the user’s settings in Frontier, your preference will then be applied to all future calls. 
 
Default setting: Off 
 
How to set in Frontier: 

• Change the status next to Remote Office to active by clicking on  or inactive 

by clicking on . 
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• Enter the phone number you want to access your BizPhone service from on the 
text box next to Remote Office option. 

• Click “Update” at the bottom of the screen to save the changes. 
 
How to override on handset (Not available for DECT handsets): 
Menu → Call Control → Remote Office → “Off” (to de-activate) or “On” (to activate) → Save 
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Standard Features 
 
The standard features are available on all handsets (unless specified) – these features are 
configurable via the Frontier Portal, and some features are also configurable via the handsets. 
 
Note: Not all of the Standard Features are available on BizPhone Line (ATA) plan. 

 

User Details 
User Details allows the administrator to manage and modify the user details when required. For 
example, when a user leaves the company, the administrator can replace the user details with a new 
or other user if the handset is reallocated to a different user. 
 
How do you use it? 
By changing the settings in Frontier, the preference will then be applied to all future calls. 
 
Default setting: Un-configured 
 
How to configure in Frontier: 

• To access User Details, go to the users section under BizPhone Admin (bottom part of the 
main page), click on the  icon for each user that you wish to configure and when the 
BizPhone user page appears, click on “User Details” menu on the left. 
 
Note: Below screen capture (User Details page) is for BizPhone Handset Users only. A 
BizPhone Line (ATA) user will have less menu on the left because there are fewer features 
supported. Please refer to each Features section to see which features are not supported. 
 

 
 

• Enter the user details. 

User Details Description 

First Name* Enter the first name of the user. 

Last Name* Enter the last name of the user. 

Email Address* Enter the email address of the user. 
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Mobile* Enter the mobile address of the user. 

Change Password 

New Password 
Enter a new password for the user’s Frontier user portal (if 
applicable). 

Please retype 
new password 

Retype the password you have just entered. 

 

Change Passcode 

Please enter 
Portal Passcode 

Enter a new passcode for the user’s voice portal. 

Please retype 
new passcode 

Retype your passcode you have just entered for the user’s voice 
portal. 

 
Notes:  
- * in above table indicates mandatory field and cannot be empty. 
- The specification for the User Password and Voice Portal Passcode are different. For 

User Password, please refer to: User Password specification. For Voice Portal 
Passcode, please refer to: Voice Portal Passcode specification. 

 

• Once you have finished entering the user details, click “Update” to save the details you 
have just entered or modified for the user. 

 

To return to the main page without changes, click on the  icon located at the top right of each 
BizPhone User page. 
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Handset and ATA Details 
This page displays the User’s handset or ATA device details: Device Name and MAC Address.  
 
To access the Handset/ATA details, go to the users section under BizPhone Admin (bottom part of 
the main page), click on the  icon for each user that you wish to display the handset information 
for and when the BizPhone user page appears, click on “Handset” menu on the left if you have a 
BizPhone Handset User plan or click on “ATA Details” if you have a Line (ATA) plan. 
 

 
 
 
 
Below is the BizPhone Line ATA’s Details page: 
 

 
 
Note: The Handset/ATA Details go hand-in-hand with the Replace Handset/Replace ATA feature. If 
you replace a user’s handset/ATA with a new or replacement handset/ATA, the new or replacement 
handset/ATA’s details (Device name and MAC Address) will be displayed in this page. 

 

To return to the main page, click on the  icon located at the top right of each BizPhone User 
page. 
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Simultaneous Ring 
Simultaneous Ring allows incoming calls to ring on multiple phone numbers or extensions in addition 
to user’s phone. 
 
Note: Simultaneous Ring is not available on BizPhone Line (ATA) plan. 
 
How do you use it? 
By changing the settings in Frontier, the preference will then be applied to all future calls. 
 
Default setting: Un-configured 
 
How to configure in Frontier: 

• To access Simultaneous Ring, go to the users section under BizPhone Admin (bottom part 
of the main page), click on the  icon for each user that you wish to configure and when 
the BizPhone user page appears, click on “Simultaneous Ring” menu on the left. 

 
The Simultaneous Ring is configured in 2 parts: 
1. Activate and configure Simultaneous Ring options (top part of the screen). 
2. Create criteria for the Simultaneous Ring (bottom part of the screen). 

 
Notes:  
- You need to set up a create criteria before you can activate the Simultaneous Ring 

feature for the user. 
 

 
 

- You need to set up “Schedules and Events” before you can enter a Create Criteria or 
you can use the default Time Schedule. To set up the Schedules and Events, please 
refer to Schedules and Events section in this document. 
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• Enter a Create Criteria for the user’s Simultaneous Ring.  
 

Create Criteria for Simultaneous 
Ring 

Description 

Description* 
Enter the description for the Simultaneous 
Ring criteria. 

Use Simultaneous Ring Personal 
Tick this option if you want to use the 
Simultaneous Ring Personal. 

Holiday Schedule 

(if applicable) Select the Holiday schedule 
from the drop down list. This is the schedule 
that you would have created under 
Schedules and Events. 

Time Schedule 

(if applicable) Select the Time schedule from 
the drop down list. This is the schedule that 
you would have created under Schedules 
and Events. 

Calls From 

You can specify if you want the phone to 
ring simultaneously when you receive call 
from: 
- Any Phone Numbers, where the user’s 

phone will ring simultaneously with the 
specified phone number(s) when they 
receive calls from any numbers. 

- Following Phone Numbers, where the 
user’s phone will ONLY ring 
simultaneously with the specified phone 
number(s) when they receive calls from 
the specified phone numbers in this 
section. If you select this option, you will 
need to specify each phone number in 
each text box located under this option. 
You can specify up to 12 phone 
numbers. 

 
Note: * in above table indicates mandatory field and cannot be empty. 

 

• Click “Save” at the bottom of the Create Criteria section to save the Simultaneous Ring 
criteria you have just created.  
 
When the Criteria is successfully created, it will be displayed at the bottom of the screen 
under “Configured Criteria”. You can update the criteria by changing the details on the 
criteria and click on the “Update” button below the criteria section. Or you can delete the 
criteria by clicking on the “Delete” button below the criteria section. 
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Note: You can create more than one Create Criteria by repeating the Create Criteria steps 
above. 
 

• After you create the criteria for the Simultaneous Ring, you can now activate and enter the 
Simultaneous Ring options. 
 

Simultaneous Ring Options Description 

Set Active Enable this option to activate the Simultaneous Ring. 

Do Not Ring My 
Simultaneous Ring 
Numbers if I’m already in a 
call 

Enable this option if you do not want the incoming 
calls to ring the additional numbers if the user is 
already in a call. 

Simultaneous Ring Numbers 

Phone Number 
Enter the phone number(s) that you want to ring at 
the same time as the user’s phone number for any 
incoming calls. 

Answer Confirmation 
Required 

Enable this option to prevent callers from being 
transferred to the specified phone’s voicemail. 

 

• Click “Update” to save the changes. 
 

To return to the main page without changes, click on the  icon located at the top right of each 
BizPhone User page. 
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Sequential Ring 
Sequential Ring allows the user to receive a call on multiple phones or devices in sequential 
order. 
 
 
Note: Sequential Ring is not available on BizPhone Line (ATA) plan. 

 
How do you use it? 
By changing the settings in Frontier, the preference will then be applied to all future calls. 
 
Default setting: Un-configured 
 
How to configure in Frontier: 

• To access Sequential Ring, go to the users section under BizPhone Admin (bottom part of 
the main page), click on the  icon for each user that you wish to configure and when the 
BizPhone user page appears, click on “Sequential Ring” menu on the left. 

 
The Sequential Ring is configured in 2 parts: 
1. Activate and configure Sequential Ring options (top part of the screen). 
2. Create criteria for the Sequential Ring (bottom part of the screen). 

 
Notes: 
- You need to set up a create criteria before you can activate the Sequential Ring 

feature.  
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- You need to set up “Schedules and Events” before you can enter a Create Criteria or 
you can use the default Time Schedule. To set up the Schedules and Events, please 
refer to Schedules and Events section in this document. 

 

• Enter a Create Criteria for the user’s Sequential Ring.  
 

Create Criteria for 
Sequential Ring 

Description 

Description* Enter the description for the Sequential Ring criteria. 

Use Sequential Ring 
Tick this option if you want to use the Sequential 
Ring. 

Holiday Schedule 
(if applicable) Select the Holiday schedule from the 
drop down list. This is the schedule that you would 
have created under Schedules and Events. 

Time Schedule 
(if applicable) Select the Time schedule from the drop 
down list. This is the schedule that you would have 
created under Schedules and Events. 

Calls From 

You can specify if you want the phone to ring 
sequentially when the user receives call from: 
- Any Phone Numbers, where the specified phone 

number will ring in sequence to the user’s phone 
when they receive calls from any numbers. 

- Following Phone Numbers, where the specified 
phone will ONLY ring in sequence to the user’s 
phone when they receive calls from the specified 
phone numbers in this section. If you select this 
option, you will need to specify each phone 
number in each text box located under this 
option. You can specify up to 12 phone numbers. 

 
Note: * in above table indicates mandatory field and cannot be empty. 
 

• Click “Save” at the bottom of the Create Criteria section to save the Sequential Ring criteria 
you have just created.  
 
When the Criteria is successfully created, it will be displayed at the bottom of the screen 
under “Configured Criteria”. You can update the criteria by changing the details on the 
criteria and click on the “Update” button below the criteria section. Or you can delete the 
criteria by clicking on the “Delete” button below the criteria section. 
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Note: You can create more than one Create Criteria by repeating the Create Criteria steps 
above. 
 

• After you create the criteria for the Sequential Ring, you can now activate and enter the 
Sequential Ring options. 

 

Sequential Ring 
Options 

Description 

Use Base Location 
First 

Enable this option if you want all incoming calls to go to the 
primary number first before it rings the other phone 
numbers. 

Number of Rings* 
Select the number of rings from the drop down list before 
the incoming calls rings the other phone numbers. 

Continue the search 
process if the base 
location is busy 

Enable this option if you want the service to continue to 
search if the primary number is busy. 

Enable caller to skip 
the search process. 
Assumes forwarding 
or messaging is 
enabled 

Enable this option to allow callers to terminate the search 
process and be put into voicemail or to the forwarding 
option. 

Locations 

ID This is a default ID set in the system. 

Phone Number Enter the Phone number for the additional phone. 

Number of Rings 
Select from the drop down list the number of rings before it 
reaches the specified phone number. 

Answer Confirmation 
Enabled this option to prevent callers from being 
transferred to the specified phone’s voicemail. 

 
Note: * in above table indicates mandatory field and cannot be empty. 
 

• Click “Update” to save the changes. 
 

To return to the main page without changes, click on the  icon located at the top right of each 
BizPhone User page. 
 

Call Forwarding Selective 
Call Forwarding Selective sends specific calls to another phone number. 
 
Note: Call Forwarding Selective is not available on BizPhone Line (ATA) plan. 

 
How do you use it? 
By changing the settings in Frontier, the preference will then be applied to all future calls. 
 
Default setting: Un-configured 
 
How to configure in Frontier: 

• To access Call Forwarding Selective, go to the users section under BizPhone Admin (bottom 
part of the main page), click on the  icon for each user that you wish to configure and 
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when the BizPhone user page appears, click on “Call Forwarding Selective” menu on the 
left. 

 
The Call Forwarding Selective is configured in 2 parts: 
1. Activate and configure Call Forwarding Selective options (top part of the screen). 
2. Create criteria for the Call Forwarding Selective (bottom part of the screen). 

 
Notes:  
- You need to enter a phone number to the “Default Forward To Number” field before 

you can set up a create criteria. Alternatively, you can also forward all calls to the Voice 
Mail by entering *55 in front of the 10-digit phone number or in front of the phone 
extension. The system default number of rings before a call is forwarded to a voice 
mail is 3 rings (18-20 seconds). 
 
The create criteria option will only appear once you have entered the “Default Forward 
To Number”. 

 
 

 
- You need to set up a create criteria before you can activate the Call Forwarding 

Selective feature. 
 

- You need to set up “Schedules and Events” before you can enter a Create Criteria or 
you can use the default Time Schedule. To set up the Schedules and Events, please 
refer to Schedules and Events section in this document. 
 

• Enter the “Default Forward to Number” and click “Update”. The Create Criteria Options will 
now appear. 
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• Enter a Create Criteria for the user’s Call Forwarding Selective. 
 

Create Criteria for 
Call Forwarding 
Selective 

Description 

Description* 
Enter the description for the Call Forwarding Selective 
criteria. 

Holiday Schedule 
(if applicable) Select the Holiday schedule from the drop 
down list. This is the schedule that you would have created 
under Schedules and Events. 

Time Schedule 
(if applicable) Select the Time schedule from the drop down 
list. This is the schedule that you would have created under 
Schedules and Events. 

Forward To Select where you want to forward the call to. 
- Default number: tick this option if you want to forward 

calls to the number you specified on the “Default 
Forward to Number”. 

- Specified Number: tick this option if you want to 
forward calls to a specified number and specify the 
phone number. 

- Do Not Forward: tick this option if you do not want to 
call forward. 

Forward From Select what phone number you want to call forward from. 
- Any Phone Number: tick this option if you want to 

forward calls from any phone number. 
- Following Phone Number: tick this option if you only 

want to forward calls from specific phone numbers. If 
you select this option, you will need to specify each 
phone number in each text box located under this 
option. You can specify up to 12 phone numbers. 

 
Note: * in above table indicates mandatory field and cannot be empty. 
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• Click “Save” at the bottom of the Create Criteria section to save the Call Forwarding 
Selective criteria you have just created.  
 
When the Criteria is successfully created, it will be displayed at the bottom of the screen 
under “Configured Criteria”. You can update the criteria by changing the details on the 
criteria and click on the “Update” button below the criteria section. Or you can delete the 
criteria by clicking on the “Delete” button below the criteria section. 
 

 
 
Note: You can create more than one Create Criteria by repeating the Create Criteria steps 
above. 
 

• After you create the criteria for the Call Forwarding Selective, you can now activate and 
enter the Call Forwarding Selective options. 
 

Call Forwarding 
Selective Options 

Description 

Set Active* Enable this option to activate the Call Forwarding Selective. 

Play Ring Reminder* 
Enable this option to play a short ring to remind the user 
that calls are being forwarded to another phone number. 

Default Forward to 
Number* 

Enter the default number to call forward to. 

 
Note: * in above table indicates mandatory field and cannot be empty. 
 

• Click “Update” to update the Call Forwarding Selective options. 
 

To return to the main page without changes, click on the  icon located at the top right of each 
BizPhone User page.  
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Priority Alert 
When Priority Alert is enabled, the user phone will ring with a distinctive ring allowing the user to 
know that the calls are from a specific person or group of people (specified in the create criteria). 
 
Note: Priority Alert is not available on BizPhone Line (ATA) plan. 

 
How do you use it? 
By changing the settings in Frontier, the preference will then be applied to all future calls. 
 
Default setting: Un-configured 
 
How to configure in Frontier: 

• To access Priority Alert, go to the users section under BizPhone Admin (bottom part of the 
main page), click on the  icon for each user that you wish to configure and when the 
BizPhone user page appears, click on “Priority Alert” menu on the left. 

 

 
 

• Select and Enter the Priority Alert Create Criteria. 
 

Note: You need to set up “Schedules and Events” before you can enter a Create Criteria or 
you can use the default Time Schedule. To set up the Schedules and Events, please refer to 
Schedules and Events section in this document. 

 

Priority Alert 
Create Criteria 

Description 

Description* Enter the Description for the Priority Alert 

Holiday 
Schedule 

(if applicable) Select the Holiday schedule from the drop down 
list. This is the schedule that you would have created under 
Schedules and Events. 

Time Schedule 
(if applicable) Select the Time schedule from the drop down list. 
This is the schedule that you would have created under 
Schedules and Events. 
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Use Priority 
Alert 

Enable this option to use Priority Alert 

Calls from 

Select “Any External Phone Number” if you wish to enable the 
Priority alert for any calls from external phone or select 
“Following Phone Numbers” if you wish to enable the Priority 
Alert for the listed phone numbers. If you select this option, you 
will need to specify each phone number in each text box located 
under this option. You can specify up to 12 phone numbers. 

 
Note: * in above table indicates mandatory field and cannot be empty. 
 

• Click “Save” at the bottom of the Create Criteria section to save the Priority Alert criteria 
you have just created.  
 
When the Criteria is successfully created, it will be displayed at the bottom of the screen 
under “Configured Criteria”. You can update the criteria by changing the details on the 
criteria and click on the “Update” button below the criteria section. Or you can delete the 
criteria by clicking on the “Delete” button below the criteria section. 
 

 
 
Note: You can create more than one Create Criteria by repeating the Create Criteria steps 
above. 

 

To return to the main page without changes, click on the  icon located at the top right of each 
BizPhone User page. 
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Call Notify 
Call Notify sends a notification message, containing the caller’s name and number, to the email 
address specified. 
 
Note: Call Notify is not available on BizPhone Line (ATA) plan. 
 
How do you use it? 
By changing the settings in Frontier, the preference will then be applied to all future calls. 
 
Default setting: Un-configured 
 
How to configure in Frontier: 

• To access Call Notify, go to the users section under BizPhone Admin (bottom part of the 
main page), click on the  icon for each user that you wish to configure and when the 
BizPhone user page appears, click on “Call Notify” menu on the left. 

 
The Call Notify is configured in 2 parts: 
1. Entering the email address for the Call Notification (top part of the screen). 
2. Create criteria for the Call Notify (bottom part of the screen). 

 
Notes: 
- You need to set up a create criteria before you can activate the Call Forwarding 

Selective feature.  
 

 
  

- You need to set up “Schedules and Events” before you can enter a Create Criteria or 
you can use the default Time Schedule. To set up the Schedules and Events, please 
refer to Schedules and Events section in this document. 

 

• Enter a Create Criteria for your Call Notify. 
 

Call Notify 
Create Criteria 

Description 
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Description* Enter the description for the Call Notify. 

Notify Enable this option to activate the Call Notify. 

Holiday 
Schedule 

(if applicable) Select the Holiday schedule from the drop down list. 
This is the schedule that you would have created under Schedules 
and Events. 

Time Schedule 
(if applicable) Select the Time schedule from the drop down list. 
This is the schedule that you would have created under Schedules 
and Events. 

Calls From 

Select “Any External Phone Number” if you wish to enable the Call 
Notify for any calls from external phone or select “Following 
Phone Numbers” if you wish to enable the Call Notify for the listed 
phone numbers. Enter each of the phone numbers in each text 
box under this option. You can specify up to 12 phone numbers. 

 
Note: * in above table indicates mandatory field and cannot be empty. 
 

• Click “Save” at the bottom of the Create Criteria section to save the Call Notify criteria you 
have just created.  
 
When the Criteria is successfully created, it will be displayed at the bottom of the screen 
under “Configured Criteria”. You can update the criteria by changing the details on the 
criteria and click on the “Update” button below the criteria section. Or you can delete the 
criteria by clicking on the “Delete” button below the criteria section. 
 

 
 
Note: You can create more than one Create Criteria by repeating the Create Criteria steps 
above. 

 

• Enter the email address you wish to send call notify to in the text box next to “Send Call 
Notify to” (mandatory). 

 

• Click “Save” to save the email address entered. 
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To return to the main page without changes, click on the  icon located at the top right of each 
BizPhone User page. 
 

Busy Lamp Field 
Busy Lamp Field allows the user to watch the status of another user that are in the group of 
users assigned with Busy Lamp Field. 
 
Notes:  

- The Busy Lamp Field feature is not available on the Cordless and Conference 
handsets. It is only available on the T42G (T42S) and T48G (T48S) handsets. 

- The user will only be able to monitor up to 50 users. 
- The Busy Lamp Field feature is not available on BizPhone Line (ATA) plan. 

 
How do you use it? 
By changing the settings in Frontier, the preference will then be applied to all future calls. 
 
You will be able to monitor the status of the users if they are added to the Assigned users 
list. 
To see the status of a user, look at the icon next to their name. 

• A head/green light means their line is free. 

• A stop/red light means their line is in use. 
 
To dial the user, just press the button next to their name. 
 
Default setting: Un-configured 
 
How to configure in Frontier: 

• To access Busy Lamp Field, click on “Busy Lamp Field” menu on the left. 
 

 

 
 

• You can add the available users to the assigned users group by highlighting the user that 

they want to monitor from the “Available users” and click the  button. The selected 
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user should now appear in the “Assigned users” list. Repeat the same steps if you wish to 
add more users to the list. 
 

To remove the user from the “Assigned users” list, highlight the user and click the  
button. Repeat the same steps if you wish to remove more users from the list. 

 

• Click “Update” to save the changes. 
 

• If this is the first time the Busy Lamp Field is configured for the user, you will 
need to reboot the user’s handset to get the Busy Lamp Field to work on their 
handset. 

 

To return to the main page without changes, click on the  icon located at the top right of each 
BizPhone User page. 
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Speed Dial 8 
Speed Dial 8 allows you to define up to 8 frequently dialled numbers and have them dialled using a 
single key on the handset. 
 
How do you use it? 
Once the Speed Dial 8 is configured in the Frontier portal (or handset), pick up the phone and press 
the single number of the speed dial (2-9) and then press “Send”. 
 
Default setting: Un-configured 
 
How to configure in Frontier: 

• To access Speed Dial 8, go to the users section under BizPhone Admin (bottom part of the 
main page), click on the  icon for each user that you wish to configure and when the 
BizPhone user page appears, click on “Speed Dial 8” menu on the left. 
 
Note: Below screen capture (Speed Dial 8) is for BizPhone Handset Users only. A BizPhone 
Line (ATA) user will have fewer options in the menu on the left, as there are fewer features 
supported. Please refer to each Features section to see which features are not supported. 
 

 
 

• Enter the phone number next to the “Phone Number” of each Speed Dial code. You can 
also enter the description, for example the user’s name next to the “Description”. The 
number indicates the number that you should enter for the Speed Dial.  
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For example: If you enter a phone number under “#2” and you wish to call the number via 
Speed Dial, then you need to enter “2” on your handset. 
 
Note: International numbers can only be added to the Speed Dial fields when the user is 
already allowed to make international calls. 
 

• Click “Update” to save the changes. 
How to set on Handsets: 

• Lift the handset and dial *74.  

• When you hear the dial tone, enter the one-digit code (2-9) that you want to represent the 
number you want to program, followed by the complete phone number and press the “#” 
key. 

 

To return to the main page without changes, click on the  icon located at the top right of each 
BizPhone User page. 
 
 

Voice Mail 
The BizPhone Voice Mailbox is pre-configured and ready to use as soon as the user receives their 
BizPhone handset.  
 

Configuring Voice Mail settings via Frontier 
 
By configuring the user’s Voice Mail settings via the Frontier portal, the preference will apply to all 
future voice mail received by the user. 
 

• To access Voice Mail, go to the users section under BizPhone Admin (bottom part of the 
main page), click on the  icon for each user that you wish to configure and when the 
BizPhone user page appears, click on “Voice Mail” menu on the left. 
 
Note: The BizPhone Line (ATA) user needs to enable the Activate Voice Mail Feature before 
they can start using the Voice Mail feature. 
 
Below is the Voice Mail page for a BizPhone Handset User. 
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Below is the Voice Mail page for a BizPhone Line (ATA) User. 
 

 
 
 

• Select and Enter the Voice mail settings. 
 

Voice Mail Settings Description 

Activate Voice Mail 
Feature 

Enable this option if you wish to activate your Voice 
Mail. 
Note: This option is only available on BizPhone Line 
(ATA) user. The user needs to activate their Voice Mail 
before they can start using it. 

Enable voice mail to be 
used with the voice portal 

Enable this option to enable the user to access their 
voice mail via the voice portal. 

Enable voice mail to be 
forwarded as email 

Enable this option to forward the user’s voice mail to 
an email as an attachment (.wav file). 
Note: Enabling Voicemail email notifications will mean 
that you lose access to the voicemails from the voice 
portal. You will only receive all your voicemails as an 
attachment via email.  

Delivery Email Address* 
Enter the email address for the user to receive their 
voice mail on. 

Enable voice mail to be 
sent as carbon copy 

Enable this option if you wish to send a carbon copy of 
the user’s voicemail to a second email address. 

Carbon Copy Email 
Address 

Enter the email address for the voice mail to be cc’d 
to. 

Enable voice mail greeting 
Enable this option to select media file for the voice 
mail greeting 

Use existing media file 
Select this option if you wish to use an existing media 
file for the voice mail greeting, and select one of the 
media files from the drop down list. 

Upload new media file^ 
Select this option if you wish to upload a new media 
file for the voice greeting. 
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Notes: 

• * in above table indicates mandatory field and cannot be empty. 

• ^ audio file needs to be in .WAV or .WMA format with specific requirements. Please refer 
to Audio File Specifications for the list of requirements.. 
 

• Click “Update” to save the changes. 
 

To return to the main page without changes, click on the  icon located at the top right of each 
BizPhone User page. 
 

Accessing your Voice Mail 
 
You can access your Voice Mail via your BizPhone handset or any external number (including 
Mobile). 
 
To access your Voice Mail via your BizPhone handset please refer to each of the handset guide 
(depending on your handset model).  
 
To access your Voice Mail via an external number: 

• Dial one of the following Voice Portal Numbers. 
 

City Voice Portal Number 

Adelaide 08 8220 9999 

Brisbane 07 3144 9999 

Canberra 02 6210 9999 

Melbourne 03 9909 9999 

Perth 08 6266 9999 

Sydney 02 8022 9999 

 

• Follow the voice prompt and enter your Mailbox ID followed by a “#”.  
 
Note: Your Mailbox ID is your BizPhone Number.  
 

• Follow the voice prompt and enter your Voice portal passcode followed by a “#”. 
 
Note: Your voice portal passcode is emailed to you with your BizPhone Service Completion 
Advice. 
 

• Press “1” to enter your Voice Mail box and then press “1” again to listen to your message(s) 
(follow the voice prompt). 

 
 

 

 

 

 
 

Voice Mail Greetings 
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You can also record your Voice Mail greetings via the Voice portal by following the same steps above 
(up to entering your Voice portal passcode) and followed by the steps below (depending on each 
Greetings you want to record). 
 
Busy Greetings 
Busy Greetings are the greetings that callers will hear if you have the Do Not Disturb feature 
activated or if you are on a call and do not have Call Waiting activated. 
 
To record your Busy Greetings: Access your Voice Mail (using the steps above – up to entering your 
Voice Portal passcode) and Press “1” to enter your Voice Mail box, followed by “2” to access your 
Busy Greetings, and then press “1” to record your Busy Greetings. Follow the voice prompt and 
record your Busy Greetings. 
 
No Answer Greetings 
No Answer Greetings are the greetings that callers will hear if you do not answer their calls. 
 
To record your No Answer Greetings: Access your Voice Mail (using the steps above – up to entering 
your Voice Portal passcode) and Press “1” to enter your Voice Mailbox, followed by “3” to access 
your No Answer Greetings, and then press “1” to record your Busy Greetings. Follow the voice 
prompt and record your No Answer Greetings. 
 
Extended Away Greetings 
Extended Away Greetings are the greetings that callers will hear if you plan to be away from your 
desk for an extended amount of time. You are required to activate and deactivate this greetings 
manually. 
 
To record your Extended Away Greetings: Access your Voice Mail (using the steps above – up to 
entering your Voice Portal passcode) and Press “1” to enter your Voice Mailbox, followed by “4” to 
access your Extended Away Greetings, and then press “3” to record your Extended Away Greetings. 
Follow the voice prompt and record your Extended Away Greetings.  

 
After you record your Extended Away Greetings, you are required to activate the greetings by 
pressing “1”. 
Once you have the greetings activated, you will be reminded each time you log in to listen to 
messages that this greeting is activated. To de-activate your Extended Away Greetings, follow step 1-
2 above and press “2”. 

 
Note: When the Extended Away Greetings are activated, the callers are not able to leave a voice 
message. Once it is de-activated, voicemail collection is turned back on. 
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Replace Handset/ATA 
Replace Handset/ATA allows the admin to select a different MAC Address for the user’s handset/ATA 
that has been assigned to them to replace the existing handset/ATA (faulty, etc). 
 
How do you use it? 
By changing the settings in Frontier, the preference will then be applied to the user. 
 
How to configure in Frontier: 

• To access Replace Handset/ATA, go to the users section under BizPhone Admin (bottom 
part of the main page), click on the  icon for each user that you wish to configure and 
when the BizPhone user page appears, click on “Replace Handsets” menu on the left, or 
click on “Replace ATA” to replace ATA device. 
 
Below is the Replace Handsets page for a BizPhone Handset User. 
 

 
 
Below is the Replace ATA page for a BizPhone Line (ATA) User. 
 

 
• Select the MAC Address of the new handset/ATA from the drop down list next to “Select 

available handset/ATA”. 
 

• Click “Update” to assign the MAC Address to the user. 
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To return to the main page without changes click on the  icon located at the top right of each 
BizPhone User page. 
 
Notes: 

- Once you replace your existing handset/ATA with a new or replacement handset/ATA, the 
details on the Handset/ATA section should be updated with the new or replacement 
handset/ATA details. 

- You need to reboot your new handset/ATA to push the user configuration to this new 
device. 

 

 

Basic Call Logs 
Basic Call Logs allows the admin to view the user’s calls history. 
 
How to access Basic Call Logs in Frontier: 
To access Basic Call Logs, go to the users section under BizPhone Admin (bottom part of the main 
page), click on the  icon for each user that you wish to configure and when the BizPhone user 
page appears, click on “Basic Call Logs” menu on the left. 
 
There are 3 types of Basic Call Logs that the user can view: Placed, Received, and Missed. By default 
the page will show the history for Placed calls. To view the Received or Missed calls, click on the 
“Received” or “Missed” under the Basic Call Logs (next to “Placed). 
 
Note: Below screen capture (Basic Call Logs) is for BizPhone Handset Users only. A BizPhone Line 
(ATA) user will have fewer options in the menu on the left, as there are fewer features supported. 
Please refer to each Features section to see which features are not supported. 
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To return to the main page, click on the  icon located at the top right of each BizPhone User page. 

 

Client Downloads 
Client Downloads is where the admin can download and access the Add-Ons such as: the Desktop 
and Mobile Apps for the Softphone Plan and the Receptionist App. 
 
Notes:  

- The link to the Apps are only available if you have purchased these Add-Ons for the users. 
- Since SoftPhone option is not available for BizPhone Line (ATA) Users, the “Client 

Downloads” option will not be available as one of the BizPhone User Features for BizPhone 
Line (ATA) Users. 

 
How to access Client Downloads in Frontier: 
 

• To access Client Downloads, go to the users section under BizPhone Admin (bottom part of 
the main page), click on the  icon for each user that you wish to configure and when the 
BizPhone user page appears, click on “Client Downloads” menu on the left. 
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How to download the Mobile App: 

You will need to download the Mobile App via your Mobile phone. Click on either of the  
icons. The left one is for Android and the right one is for iPhone (referenced under the 
“Broadsoft UC-One Client” next to the icon). The Android App is available on Google Play and 
the iPhone App is available on the AppStore. 
 

 
 
For details on what the Mobile App is and how to use it, please refer to the BizPhone Mobile 
App section of this document. 
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How to download the Desktop App: 

Click on the   icon. The left one is for Windows Operating System and the right one is for 
Macintosh Operating System (referenced under the “BizPhone Communicator” next to the 
icon). Once you click on the icon, a window will pop up to save the BizPhone Communicator 
setup file. You can then save the .exe or .dmg file for installation. 
 

 
 
For details on what the Mobile App is and how to use it, please refer to the BizPhone 
Desktop App section of this document. 
 



 

    P a g e | 49 
 

Public 

 
How to access the Receptionist App: 

Receptionist App is a web-based Application and can be accessed by clicking the , where 
a new tab will be open up on the same browser. Enter the User ID and Password you have 
been given on your Service Completion Advice to access the Receptionist App. 
 

 
 
For details on how to use the BizPhone Receptionist App, please refer to BizPhone 
Receptionist App section on this document. 
 
 

To return to the main page, click on the  icon located at the top right of each BizPhone User page. 
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Skype for Business 
The Skype for Business section is where the user can enable and download the Desktop App that 
has been integrated with Skype for Business (Business Communicator for Skype for Business). 
 
The Business Communicator for Skype for Business allows the user to use their Skype for Business 
app to make external calls via their BizPhone number. 
 

• After entering the phone number in the Skype for Business app, the BizPhone 
Communicator Desktop app will launch and place the call. 

• The Skype for Business app will automatically update its status to “in a call”. 

• The BizPhone user’s number will be displayed to the recipient. 
 
Notes: 

• The link to the App is only available if you have purchased this Add-On for the user. 

• Skype for Business Desktop App is only available on Windows Operating System. 

• Although you will be able to make external calls through the Skype for Business app, 
incoming calls will still need to be answers via the BizPhone Communicator Desktop App.  

• Users cannot use this feature to add/call an external party to a Lync/Skype meeting. 

• Since SoftPhone option is not available for BizPhone Line (ATA) Users, the “Client 
Downloads” option will not be available as one of the BizPhone User Features for BizPhone 
Line (ATA) Users. 

 
How to Access Skype for Business in Frontier: 
 

• To access Skype for Business, click on “Skype for Business” menu on the left. 
 

 
 

• Click on the  icon to download the Business Communicator for Skype for Business. Once 
you click on the icon, a window will pop up to save the Business Communicator setup file. 
You can then save the .exe file for installation. 
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Follow the process on how to install the Desktop App. See BizPhone Desktop App section of 
this document for more information. 
 
Note: Before you can start using the Business Communicator for Skype for Business, you 
will need to enable the Skype for Business option on the page. 
 

• Enable the Skype for Business option and click “Update”. 
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Group Features 
The group features are the services that are available at the “group” level and only 
configurable via the Frontier Admin Portal. 
 

Hunt Group 
Hunt Group offers a method of distributing any inbound calls to a group of phones that 
are defined by the admin. 
 
The admin can choose how the users are included in a Hunt Group and the method of 
incoming calls distribution. There are 4 different distribution methods available. 
 
Circular 
This method sends incoming calls to users in the order listed by the administrator. The call will 
go to the user following the user that answered the last call. 

 
 
Regular 
This method sends incoming calls to users in the order listed by the administrator. The call will go to 
the first available person in the list. 

 
 
 
 
Simultaneous 
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This method sends incoming calls to all the users listed by the administrator at the same time.  
 

 
 
Uniform 
This method sends incoming calls to the user who’s been idle the longest. Once a user completes 
a call they are moved to the bottom of the call queue.  
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How to configure in Frontier: 

• To access the Hunt Group, go to the BizPhone Main page and on the “BizPhone Admin” 
section, you will see “BizPhone Hunt Group”. Click on the  icon for each Hunt Group that 
you wish to configure.  

 

 
 
Once you click on the  icon of the Hunt Group, the below page will appear (next page). 
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• Enter and select the settings for the Hunt Group. 
 

Settings Description 

General 

Set Active Enable this to activate the Hunt Group. 

Hunt Group ID This ID is allocated by default. 
Hunt Group Name* Enter a name for the Hunt Group. 

CLID First Name* Enter a First Name for the Hunt Group. 

CLID Last Name* Enter a Last Name for the Hunt Group. 

Phone Number This Phone Number is allocated by default. 

Voice Mail Settings 

Activate Voice Mail 
Feature 

Enable this to activate the voice mail feature for the Hunt 
Group. 

Enable voice mail to be 
used with voice portal 

Enable this option if you wish to be able to listen to the 
Hunt Group voice messages through the Voice Portal. 

Enable voice mail to be 
forwarded as email 

Enable this option if you wish to send a copy of the Hunt 
Group voice mail to an email and enter the email 
address in the field. 

Delivery Email Address Enter the email address for the voice mail to be sent to. 

Enable voice mail to be 
sent as carbon copy 

Enable this option if you wish to send a carbon copy of 
the Hunt Group voice mail to a second email address. 

CC Email Address Enter the email address for the voice mail to be CC’d to. 

Enable voice mail media 
file 

Enable this option if you wish to select a media file for 
the Hunt Group voice mail. 

Select Media File^ Select the available media file from the drop down list. If 
there is no media file available, please upload the file. 
See note below for more information. 

Call Routing 

Call Waiting on Agents Enable this to allow Call waiting on the assigned 
users/agents. 
Note: If all users are busy in a hunt group, calls will fail 
unless you enable this option and Call Waiting feature on 
each agent.  With Call Waiting (each agent) and this 
option enabled, the calls will be treated as not answered 
and overflow when no answer timer expires. 

Allows members control 
Group Busy 

Enable this to give group members control over the 
Group Busy policy. 

Enable Group Busy Enable this to allow group busy policy for the Hunt 
Group. 
Note: Enabling Group Busy does not mean that calls will 
overflow. Overflow is only for “Not Answer” and “Not 
Reachable” conditions. If you enable Group Busy, all 
calls will fail to fast busy tone unless Call Forward Busy is 
enabled. 

Apply Group Busy when 
terminating Call to agent 

Enable this to always apply the Enable Group Busy policy 
when calls are made through the directory hunting 
number. 

Group Policy Select one of the Hunt Group distribution methods 
(described earlier in this section). 

No Answer Settings 
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Call Forward To* 

Enter the phone number to forward calls to when there 
is no answer. Alternatively, calls can also be forward to 
Voice Mail by entering *55 in front of the 10-digit phone 
number of in front of the phone extension. 
Note: This must be one of your BizPhone Phone 
Numbers. 

Skip to next agent after 
xx rings 

Specify the number of rings before the call is sent to 
next agent. 

Forward call after 
waiting xx seconds 

Specify the number of seconds before call is forwarded 
to the specified phone number. 

Not Reachable Settings  

Enable Call Forwarding 
Not Reachable 

Calls are forwarded to this number when the Hunt 
Group is unreachable. Alternatively, calls can also be 
forward to Voice Mail by entering *55 in front of the 10-
digit phone number of in front of the phone extension. 

Make Hunt group busy 
when all available 
agents are not reachable 

Enable this to send a busy tone to the caller when the 
hunt group is unreachable. 

  

Call Forwarding (Always/Busy) – only available on a non-complimentary or Billable 
Hunt Group 

Always 

Enable this to forward all calls to a specified number 
when the Hunt Group is unreachable. Alternatively, calls 
can also be forwarded to Voice Mail by entering *55 in 
front of the 10-digit phone number or in front of the 
phone extension. 

Busy 

Enable this to forward all calls to a specified number 
when the Hunt Group is busy. Alternatively, calls can 
also be forwarded to Voice Mail by entering *55 in front 
of the 10-digit phone number or in front of the phone 
extension. 

Call Forwarding Selective – only available on a non-complimentary or Billable Hunt 
Group 

Enable 

Enable this to forward specific calls to a specified 
number. Alternatively, calls can also be forwarded to 
Voice Mail by entering *55 in front of the 10-digit phone 
number or in front of the phone extension. 

Play Ring Reminder 
Enable this option if you wish to play reminder for Call 
Forwarding. 

Default Forward To Enter a default forwarding number. 

New Criteria (see red 
notes below) 

Description 
Enter the description for the Call 
Forwarding here. 

Holiday Schedule 
Select the Holiday Schedule you 
have defined under Schedule and 
Events 

Time Schedule 
Select the Time Schedule you 
have defined under Schedule and 
Events 

Forward To 
Select “Default Number” if you 
wish to forward the calls to the 
default number specified. 
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Select “Specified Number” if you 
wish to forward the calls to a 
specified number. Enter the 
specified number in the text box 
next to this option. 

Select “Do Not Forward” if you do 
not wish to forward your calls to a 
phone number. 

Calls From 

Select “Any Phone Number” if 
you wish to forward calls from 
any phone number. 

Select “Following Phone 
Numbers” if you wish to only 
forward calls from certain 
numbers. Specify the phone 
numbers in the text boxes. 

Calling ID Settings  

Use System Default 
Hunt Group 

Use the CLID settings defined by default. 

Include Hunt Group 
name in CLID 

Use the Hunt Group name specified in the General 
settings as the CLID. 

Assigned BizPhone Users 

Group Members 

Assign the BizPhone Users to the Hunt Group by 
highlighting the user you wish to add from the “Available 

BizPhone Users” list and click the  button and the 
user will be added to the assigned list. 
To add more users, repeat the same steps. 
To remove user from the “Assigned BizPhone List”, click  

 button and the user will be removed from the list. 

 
Notes: 

- * in above table indicates mandatory field and cannot be empty. 
- ^ To upload the media file, please refer to the Upload Announcement section in this 

document. 
- Call Forwarding Always/Busy and Call Forwarding Selective are only available for Billable 

(non-complimentary) Hunt Groups. 
- You need to set up a New Criteria before you can activate the Call Forwarding Selective 

Feature. 
- You need to set up “Schedules and Events” before you can enter a New Criteria or you can 

use the default Time Schedule for Call Forwarding Selective. To set up the Schedules and 
Events, please refer to Schedules and Events section in this document. 

- Collapsed Criteria will not be updated on submit. You need to expand the Criteria to 
update. 

 
• Once you have finished configuring all options, click “Update” at the bottom of the 

screen and it will save the Hunt Group settings that you have just configured. 
 

To return to the main page without changes, click on the  icon located at the top right of each 
BizPhone Hunt Group page. 
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Queue 
Queue allows the user to queue incoming calls when all the phones are busy until you are able to 
answer the calls. This is useful during peak times where your business is in high demand. 
 
There are 5 different Queue methods available. 
 
Circular 
This method sends incoming calls to users in the order listed by the administrator. The call will 
go to the user following the user that answered the last call. 
 
Regular 
This method sends incoming calls to users in the order listed by the administrator. The call will 
go to the first available person in the list. 
 
Simultaneous 
This method sends incoming calls to all the users listed by the administrator at the same time.  
 
Uniform 
This method sends incoming calls to the user who’s been idle the longest. Once a user completes 
a call they are moved to the bottom of the call queue.  
 
Weighted Call Distribution 
This method send incoming calls randomly to agents according to percentages you assign on the 
Call Centre. 
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How to configure in Frontier: 

• To access the Queue, go to the BizPhone Main page and on the “BizPhone Admin” section, 
you will see “BizPhone Queue” and click on the  icon for each Hunt Group that you wish to 
configure.  
 

 
 
Once you click on the  icon of the Queue, below page will appear (next page). 
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• Enter and select the Queue settings. 
 

Settings Description 

General 

Set Active Enable this to activate the queue. 

Queue ID This ID is allocated by default. 

Queue Name* Enter a name for the Queue. 

CLID First Name* Enter a First Name for the Queue. 

CLID Last Name* Enter a Last Name for the Queue. 

Phone Number This Phone Number is allocated by default. 

Group Policy 
Select one of the Queue methods (described earlier in 
this section). 

Queue Settings 

Allows callers to dial 0 to 
escape out of queue 

Enable this if you want the callers to have the ability to 
press “0” to escape out of the queue. 

Play ringing when offering 
call 

Enable this to enable play ringing when offering a call 
to an agent in lieu of the caller hearing music on hold. 
This lets the caller knows their call is about to be 
answered. 

Reset caller statistics 
upon entry to queue 

Enable this if you require caller statistics to be reset 
each time the agents log into a queue. 

Queue Length (Calls) 
The maximum number of calls that can be queued at 
any one time. 

Voice Mail Settings 

Activate Voice Mail 
Feature 

Enable this to activate the voice mail feature for the 
Queue. 

Enable voice mail to be 
used with voice portal 

Enable this option if you wish to be able to listen to the 
Queue voice messages through the Voice Portal. 

Enable voice mail to be 
forwarded as email 

Enable this option if you wish to send a copy of the 
Hunt Group voice mail to an email and enter the email 
address in the field. 

Delivery Email Address Enter the email address for the voice mail to be sent 
to. 

Enable voice mail to be 
sent as carbon copy 

Enable this option if you wish to send a carbon copy of 
the Queue voice mail to a second email address. 

CC Email Address Enter the email address for the voice mail to be CC’d 
to. 

Enable voice mail media 
file 

Enable this option if you wish to select a media file for 
the Queue voice mail. 

Select Media File^ Select the available media file from the drop down list. 
If there is no media file available, please upload the 
file. See note below for more information. 

Entrance Announcement Settings 

Play Entrance 
Announcement 

Enable this option to play the Entrance Announcement 
for the Queue 

Announcement Type Select Announcement Type. 
Choose “Default” if you wish to use the system default 
Announcement. 
Choose “Custom” if you wish to use a Custom 
Announcement and then select the media file. 
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Select Media File^ This option is only displayed when you choose 
“Custom” Announcement Type. Select the media file 
from the drop down list. If there is no media file 
available, please upload 

On-Hold Announcement Settings 

Enable Media On-Hold 
Announcement 

Enable this option to play Announcement when the 
caller is On-Hold in the queue. 

Announcement Type 
Select Announcement Type. 
Choose “Default” if you wish to use the system default 
Announcement. 

Select Media File^ 

This option is only displayed when you choose 
“Custom” Announcement Type. Select the media file 
from the drop down list. If there is no media file 
available, please upload the file. 

Routing Settings 

Bounce calls after xx rings 
Enable and Select how many rings before the calls are 
bounce to next agent if they are unanswered. 

Enable overflow after call 
wait xx seconds 

Enable and Select how many seconds to wait before 
the calls are overflow to the next agent. 

Play announcement 
before overflow 
processing  

Enable this to play announcement to the caller before 
the call is overflowed. 

Overflow Action Select one of the overflow routing options. 

Transfer to Phone 
Number 

Enter the phone number to transfer the call to if you 
select to transfer to phone number as the Overflow 
Action. 

Agent Settings 

Allow call waiting on 
Agents 

Tick this box to allow agents to have the ability to 
handle more than once call at a time. Agents must also 
have the Call Waiting feature enabled on the user 
profile. 

Assigned BizPhone Users 

Group Members 

Assign the BizPhone Users to the Queue by 
highlighting the user you wish to add from the 

“Available BizPhone Users” list and click the  
button and the user will be added to the assigned list. 
To add more users, repeat the same steps. 
To remove user from the “Assigned BizPhone List”, 

click   button and the user will be removed from 
the list. 

 
Note: * in above table indicates mandatory field and cannot be empty. 
           ^ To upload the media file, please refer to the Upload Announcement section in this           
______document. 

 

• Click “Update” at the bottom of the page to save the Queue settings that you have just 
configured. 

To return to the main page without changes, click on the  icon located at the top right of 
each BizPhone Queue page. 
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Music on Hold 
Music on Hold plays music while callers are on hold. This feature allows the group administrator to 
upload the audio file for the Music on Hold. 

 
How to configure in Frontier: 

• To access the Music on Hold, click on the  icon next to “vPBX Music On Hold” on the main 
page.  

 

 
 
The Music On Hold page will appear (below). 
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• Select the Music on Hold settings. 
 

Profile Description 

Enable music/video 
during Call Hold 

Enable this if you wish to play music for callers that are on 
hold. 

System 
Tick this option if you wish to use system defined Music on 
Hold. 

Custom Music/Video 
File 

Tick this option if you wish to use a custom audio file for 
Music on Hold. 

Use existing audio 
file 

Tick this option if you have existing audio file and wish to 
use it. 

Upload new audio 
file 

Tick this option to upload a new audio file and choose file 
to upload. 

 
Note: The audio file needs to be in .WAV or .WMA format with specific requirements. 
Please refer to Audio File Specifications for the list of requirements. 
 

• Click “Update” to save the Music on Hold settings that you have just configured. 
 
 

To close the Music on Hold menu, click on the  icon next to “vPBX Music On Hold”. 
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Schedules and Events 
Schedules and Events allows the administrator to set up the Time schedule and Holiday schedule for 
BizPhone services. 
 
The Time schedule and Holiday schedule are used in the following BizPhone features/services: 

• Auto Attendant 

• Call Forwarding Selective 

• Simultaneous Ring 

• Sequential Ring 

• Call Notify 

• Priority Alert 
 
To route calls based on the time of the day (business or after hours), you can configure the Time 
schedule. You can also configure your company holiday schedule by identifying the dates of the 
holiday in the Holiday schedule. 
 
How to create and configure Schedules and Events in Frontier: 

• To access the Schedules and Events, click on the  icon next to “Schedules and Events” on 
the main page.  
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The Schedules and Events page will appear (below). 
 

 
 

• Create a schedule by entering the Schedule Name and the Schedule Type. 
 

Create Schedule Description 

Schedule Name* 
Enter the name for the schedule. 
For example: Christmas Holiday, etc. 

Schedule Type 

Select the required Schedule Type: 

- Holiday: if you wish to create a Holiday Schedule. 
- Time: if you wish to create a Time Schedule (Business or 

After hours). 
 
Note: * in above table indicates mandatory field and cannot be empty. 
 

• Click “Save” under the Create Schedule section to save the schedule you have just created. 
You can create multiple schedules by repeating the same steps above. 
 

• Once the Schedule is created, it will appear under Current Schedules section on the same 
screen.  
 

 
 

• To create an event for the schedule, click on the  icon next to the schedule you have 
just created and the schedule page drop down. You can now create the event for the 
schedule by clicking on the “Create Event” button. 
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• Enter and select the details for the event. 
 

Create 
Event 

Description 

Event 
Name* 

Enter a name for the event. 

Start Date* Enter the start date for the event. 

End Date* Enter the end date for the event. 

All Day 
event 

Activate this if it is an all-day event. 

Start Time* 

(if applicable) This option is disabled if you activate the All Day event. 
If it is not an all-day event, you will need to select the hours and 
minutes from the drop down list as to when you want the event to 
start. 

End Time* 

(if applicable) This option is disabled if you activate the All Day event. 
If it is not an all-day event, you will need to select the hours and 
minutes from the drop down list as to when you want the event to 
end. 

Recurrence 
Pattern 

Select one from the drop down list how you wish the event to 
reoccur: 

Never: if you do not want the event to reoccur. 
 

 
 

Daily: if you want the event to repeat daily. If you select this option, 
the Recurrence Interval and Recurrence End Date fields will appear. 
Recurrence Interval* is a mandatory field and you will need to enter 
in how many day(s) do you want the event to occur.  
Recurrence End Date is the date you want the event to end. 
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Weekly: if you want the event to occur weekly. If you select this 
option, the Recurrence Interval, the days (Monday – Sunday), and the 
Recurrence End Date fields will appear. 
Recurrence Interval* is a mandatory field and you will need to enter 
in how many week(s) do you want the event to occur and you need 
to activate at least a day for the event to occur. For example, activate 
Monday if you want the event to occur every Monday. 
Recurrence End Date is the date you want the event to end. 
 

 
 

Monthly: if you want the event to occur monthly. If you select this 
option, the Recurrence Interval, On Day, and the Recurrence End 
Date fields will appear. 
Recurrence Interval* is a mandatory field and you will need to enter 
in how many month(s) do you want the event to occur. 
On Day* is also a mandatory field and you need to enter on which 
day of the month do you want the event to occur. 
Recurrence End Date is the date you want the event to end. 
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Yearly: if you want the event to occur yearly. If you select this option, 
the Recurrence Interval, On Day, Month Of, and Recurrence End Date 
fields will appear. 
Recurrence Interval* is a mandatory field and you will need to enter 
in how many year you want the event to occur. 
On Day* is also a mandatory field and you need to enter on which 
day of the month do you want the event to occur. 
Month of* is also a mandatory field that let you select from the drop 
down list you want the event to occur. 
Recurrence End Date is the date you want the event to end. 
 

 
 

 
Notes: 
-  * in above table indicates mandatory field and cannot be empty. 
- The duration (between Start Date and End Date) must be shorter than how frequently 

it occurs (Recurrence Interval). 
 

• Click “Save” button to save the event you have just created. You can create multiple events 
for a schedule by repeating the Create Event steps above. 
 
 
 
 
Once the event is created, it will appear under “Current Events” of the schedule. You can 
modify the event by click on the “Update Event and Schedule” button. 
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Deleting an event or schedule 
 

• You can delete an event by clicking on the “Delete” button next to the event.  
 

 
 

• You can delete a schedule by clicking on the “Delete” button next to the schedule. 
 

 
 
 

To close the Schedules and Events menu, click on the  icon next to “Schedules and Events”. 
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Global Address Book 
Global Address Book allows the administrator to upload a phone book for the BizPhone service. 
Note: Global Address Book is not available on BizPhone SoftPhone plan or as part of the 
Desktop/Mobile Apps or Clients. 
 
How to configure in Frontier: 

• To access the Global Address Book, click on the  icon next to “Global Address Book” on 
the main page (next page). 
 

 
 
Global Address Book page will appear (below). 
 

 
 

• Upload a csv file for the address book by clicking on the “Choose File” button. 
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The csv file should have 2 columns: Name and Number. You can see a sample csv by clicking 
on “See sample csv” on the screen. 
 
Note: You can add up to 500 entries (contacts) to the csv file. 

• The contacts in the Global Address Book should now appears on the handset. 
 
Note: The contacts will get updated in the T48G (T48S) handset instantly, but the user will 
need to restart the T42G (T42S) handset before the contacts appear on their handset. 
 
 

How to access Global Address Book via the T42G (T42S) handset: 

• Press the “Directory” soft key on the main LCD screen. 

• Using the Up and Down button ( ) on the handset, scroll through and click on “Group 
Common”. 

• The contacts details (Name and Phone number) that you have uploaded via the Global 
Address Book in Frontier will appear on the LCD screen. 

 
 
How to access Global Address Book via the T48G (T48S) handset: 

• Press the “Directory” on the main LCD screen. 

• Click on “Group Common” menu on the left of the screen. 

• The contacts details (Name and Phone number) that you have uploaded via the Global 
Address Book in Frontier will appear on the LCD screen. 

 
 
How to access Global Address Book via the Cordless DECT handset: 

• Press “OK” button on the handset. 

• Scroll through to “Directory” menu with the down arrow button and press “OK”. 

• Select “Network Dir” by using the up and down arrow button and press “Enter” or the “OK” 
button. 

• Select “GroupCommon” by using the up and down arrow button and press “Enter” or the 
“OK” button. 

• The contacts details (Name and Phone number) that you have uploaded via the Global 
Address Book in Frontier will appear on the phone screen. 
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Advanced Features 
 

Configure Pilot Number 
Configure Pilot Number allows the administrator to select the Pilot Number (Group Number) from a 
list of phone numbers or you can select “None” if you do not want to specify a Pilot Number. 
 
How to configure in Frontier: 

• To access the Configure Pilot Number, click on the  icon next to “Advanced Features” on 
the main page.  

 

 
 
The “Configure Pilot Number” option will appear in the expanded menu (below). 
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• Select the Pilot Number from the drop down list. 
 

• Click “Update” to save the changes. 
 

To close the Configure Pilot Number option, click on the  icon next to “Advanced Features”. 
 

Call Forward Unused Numbers 
Call Forward Unused Numbers allows the administrator to choose the default number to forward 
incoming calls for unused numbers, i.e. those number(s) that are not allocated to any BizPhone user. 
 
How to configure in Frontier: 

• To access the Call Forward Unused Numbers feature, click on the  next to “Advanced 
Features” on the main page. 
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The Advanced Features page will appear (below). You are on the “Configure Pilot Number” 
page by default. 
 

 
 

• Click on the “Call Forward Unused Numbers” menu on the left. 
 

 
 
The Call Forward Unused Numbers page will appear (below). 
 

 
 

• Select the number from the drop down list. You can select “None” if you do not want to 
forward any incoming calls for the Unused Numbers. 
 

 
 
 

• Click “Update” to save the changes. 
 

To close the Call Forward Unused Numbers option, click on the  icon next to “Advanced Features”. 
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Upload Announcement 
 
Upload Announcement allows the administrator to upload media files for the group. The media files 
can be used for Group and User’s Voice Mail Greetings. 
 
How to configure in Frontier: 

• To access the Upload Announcement option, click on the  next to “Advanced Features” 
on the main page. 
 

 
 
 

The Advanced Features page will appear (next page). You are on the “Configure Pilot 
Number” page by default. 
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• Click on the “Upload Announcement” menu on the left. 
 

 
 
The Upload Announcement page will appear (below). 
 

 
 

• Choose the media file that you wish to upload by clicking on the “Choose File” button and 
then select the media file from your local machine or network drive. 
 

 
 
Note: The audio file needs to be in .WAV or .WMA format with specific requirements. Please 
refer to Audio File Specifications for the list of requirements. 
 

• Click “Upload” to upload the media file. 
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Receptionist Features 
 

Auto Attendant 
Auto Attendant is a voice menu system that plays a recorded greeting to incoming callers and allows 
them to choose to be directed to an internal extension. Sometimes this feature is referred to as IVR 
(Interactive Voice Response). 
 
An Auto Attendant can consist of one or more menus and the concept of “an instance” of an auto-
attendant is important. 
 
What is an instance of Auto Attendant? 
An instance of Auto Attendant is a single recording and menu that is assigned an internal extension. 
 
Example as shown below:  
There are two Auto Attendant instances: One for the main business number and the other one for 
Customer Service. 
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How to configure in Frontier: 
 

There are 3 parts of Auto Attendant configuration: 
 

1. Basic 
 

• To access the Auto Attendant, go to the BizPhone Main page and on the “BizPhone Admin” 
section, you will see “BizPhone Auto Attendant” and click on the  icon for each Auto 
Attendant that you wish to configure.  
 

 
 
The Auto Attendant Basic Settings page will appear (next page). 
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This page will allow you to activate and set the general settings for the Auto Attendant.  
 

• Activate and enter the basic settings for the Auto Attendant. 
 

Basic settings Description 

Set Active 
Enable this if you wish to activate the Auto Attendant and 
untick to deactivate 

General Settings 

Auto Attendant ID This ID is allocated by default. 
Auto Attendant 
Name* 

Enter a Name for the Auto Attendant. 

CLID First Name* Enter a First Name for the Auto Attendant. 
CLID Last Name* Enter a Last Name for the Auto Attendant. 

Phone Number 
The Auto Attendant phone number is allocated automatically 
when the service is provisioned. 

Voice Mail Settings 
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Activate Voice Mail 
Feature 

Enable this to activate the voice mail feature for the Auto 
Attendant. 

Enable voice mail to 
be used with voice 
portal 

Enable this option if you wish to be able to listen to the Auto 
Attendant voice messages through the Voice Portal. 

Enable voice mail to 
be forwarded as 
email 

Enable this option if you wish to send a copy of the Auto 
Attendant voice mail to an email and enter the email address 
in the field. 

Delivery Email 
Address 

Enter the email address for the voice mail to be sent to. 

Enable voice mail to 
be sent as carbon 
copy 

Enable this option if you wish to send a carbon copy of the 
Auto Attendant voice mail to a second email address. 

CC Email Address Enter the email address for the voice mail to be CC’d to. 

Enable voice mail 
media file 

Enable this option if you wish to select a media file for the 
Auto Attendant voice mail. 

Select Media File^ Select the available media file from the drop down list. If 
there is no media file available, please upload the file. See 
note below for more information. 

Scope of Dialing 

Name Dialing 
Entries 

Define how the caller should say the name of the person they 
want to reach.  
• Last + First: where the caller must first say the last name of 

the person and then say their first name. 

• Last + First or First + Last: where the caller can say either 
the last name and then the first name of the person or vice 
versa. 

 
Note: * in above table indicates mandatory field and cannot be empty. 
           ^ To upload the media file, please refer to the Upload Announcement section in this 
______document.  
 

• Click “Update” to save the Auto Attendant settings that you just configured. 
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2. Business Hours Menu 
 

• To access the Business Hours Menu for the Auto Attendant, go to the BizPhone Auto 
Attendant page and click on the “Business Hours Menu” on the left and below page will 
appear. 
 

 
 

• Select and enter the Business Hours Menu for the Auto Attendant. 
 

Business Hours 
Menu 

Description 

Audio File Selection 

Default Tick this if you wish to use the system default audio file. 

Personal 

Tick this if you wish to upload your personal audio file. 
You can use a “Default” system defined audio file or to 
upload a “Personal” audio file. 
To upload an audio file, click “Choose File” and select the 
audio file you wish to play to the callers when they reach the 
Auto Attendant. 
 
Note: The audio file needs to be in .WAV or .WMA format 
with specific requirements. Please refer to Audio File 
Specifications for the list of requirements. 
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Audio Keys 

Key 
This is the key on the handset keypad to which you assign 
actions. 

Description Optional description of the menu option. 

Action 

A Drop down list of actions: 

• Transfer to Operator: Plays the message “Please stay on 
the line while your call is transferred to the operator” and 
then transfer the call to the specified operator number. 

• Transfer With Prompt: Plays the message “Your call is being 
transferred, please hold” and then transfers the call to the 
specified number. 

• Transfer Without Prompt: Transfers the call to the specified 
number, without playing a transfer prompt. 

• Name Dialing: Brings the user into the automated name 
directory. 

• Extension Dialing: Prompts the user for an extension and 
transfer the user. 

• Repeat Menu: Replays Auto Attendant Menu options. 

• Exit: Exits user from the Auto Attendant and terminates the 
call. 

Phone Number 
When the action selected is to transfer a call, a phone 
number must be specified. 
Note: Calls to non-BizPhone numbers will be charged. 

 
3. After Hours Menu 

 

• To access the After Hours Menu for the Auto Attendant, go to the BizPhone Auto Attendant 
page and click on the “After Hours Menu” on the left and below page will appear. 
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• Select and enter the After Hours Menu for the Auto Attendant. 
 

Business Hours 
Menu 

Description 

Audio File Selection 

Default Tick this if you wish to use the system default audio file. 

Personal 

Tick this if you wish to upload your personal audio file. 
You can use a “Default” system defined audio file or to 
upload a “Personal” audio file. 
To upload an audio file, click “Choose File” and select the 
audio file you wish to play to the callers when they reach the 
Auto Attendant. 
 
Note: The audio file needs to be in .WAV or .WMA format 
with specific requirements. Please refer to Audio File 
Specifications for the list of requirements. 

Audio Keys 

Key 
This is the key on the handset keypad to which you assign 
actions. 

Description Optional description of the menu option. 

Action 

A Drop down list of actions: 

• Transfer to Operator: Plays the message “Please stay on 
the line while your call is transferred to the operator” and 
then transfer the call to the specified operator number. 

• Transfer With Prompt: Plays the message “Your call is being 
transferred, please hold” and then transfers the call to the 
specified number. 

• Transfer Without Prompt: Transfers the call to the specified 
number, without playing a transfer prompt. 

• Name Dialing: Brings the user into the automated name 
directory. 

• Extension Dialing: Prompts the user for an extension and 
transfer the user. 

• Repeat Menu: Replays Auto Attendant Menu options. 

• Exit: Exits user from the Auto Attendant and terminates the 
call. 

Phone Number 
When the action selected is to transfer a call, a phone 
number must be specified. 
Note: This must be one of your BizPhone phone numbers. 

 
 

To return to the main page without changes, click on the  icon located at the top right of each 
BizPhone Auto Attendant page. 
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Receptionist 
Receptionist allows the receptionist to assign or remove users that they can monitor through the 
Receptionist App Basic ONLY. If you have ordered the Receptionist Advanced feature, you should be 
able to use the Receptionist interface to assign and remove users and you should not use this portal 
configuration option to do so.   
 
Notes: 

- The Receptionist menu is only available on the User menu if they have been assigned the 
Receptionist App license. 

- Receptionist feature is not available on BizPhone Line (ATA) plan. 
 
How do you use it? 
By changing your setting in Frontier, your preference will then be applied to all future calls. 
 
Default setting: Un-configured 
 
How to configure in Frontier: 

• To access Receptionist, go to the users section under BizPhone Admin (bottom part of the 
main page), click on the  icon for the user that has the Receptionist feature that you wish 
to configure. When the BizPhone user page appears, click on “Receptionist” menu on the 
left. 

 

 
 

• The receptionist can add the available users to the assigned users group by highlighting the 
user that they want to monitor from the “Available users” and click the  button. The 
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selected user should now appear in the “Assigned users” list. Repeat the same steps if you 
wish to add more users to the list. 
To remove the user from the “Assigned users” list, highlight the user and click the  
button. Repeat the same steps if you wish to remove more users from the list. 
 

• Click “Update” to save the changes. 
 
 

To return to the main page without changes, click on the  icon located at the top right of the 
BizPhone User page. 
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Add-On Features & Services 
 
The Add-On features and services are value added features to the end user services. 
 

BizPhone Desktop App 
BizPhone Desktop App is the iiNet branded UC One Communicator Desktop Softphone application 
that allows the user to make and receive calls, access voicemail, and to configure their basic 
telephone features, such as Call Forwarding, Do Not Disturb, etc. For the full list of features, please 
refer to the Business Communicator User Guide Desktop. 
 
Minimum System and Hardware Requirements 
BizPhone Desktop App needs to be run on specific Operating System and hardware. The following 
are the Desktop App version 21.2.0.487 minimum system and hardware requirements. 
 

Requirements  Details 

Operating System 
Mac OS 10.8 Mountain Lion, Mac OS 10.9 Mavericks, Mac OS 10.10 
Yosemite, Windows Vista, Windows 7 or Windows 8/8.1 or Windows 10 
(Classical view only)                                                             

CPU Minimum 1.5 GHz CPU, Pentium 4, dual core CPU with 2GB RAM 

Disk space 
The installation footprint is approximately 125 megabytes (MB) on OS X 
and 215 MB on Windows       

Peripherals 
For voice calls, a sound card, speakers, and a microphone or a headset 
are required                           

 
Where do you download it? 
You can download the App via the Portal (Refer to section Client Downloads). 
 
How do you install it? (based on the Windows App) 

• Click on the set up (.exe or .dmg) file that you have downloaded. 

• Select the language from the drop down list and click “Ok”. 
 

 
 

• Click “Next” on the Welcome screen. 
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• Click “I Agree” on the License Agreement. 
 

 
 

 
 

• Click “Next” on the Install Options. 
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• Click “Next” on the Choose Install Location. 
 

 
 

• Click “Install” on the Choose Start Menu Folder. Please wait while the BizPhone 
Communicator is being installed. 
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• Your setup is completed. Click “Next”. 

 

 
 

• Click “Finish” to close the setup. 
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How do you use it? 
Launch the installed Application and Login. Your login details will be sent in an email with your 
BizPhone Service Completion Advice.  
 
Note: The login username is case sensitive. Your login username will start with a “U” which must be 
entered as uppercase. 
 
Please refer to the Business Communicator User Guide Desktop for the BizPhone Desktop App user 
manual. 
 

 
iiNet Branded BizPhone Communicator Desktop App 

 
 

BizPhone Mobile App 
BizPhone Mobile App is the Broadsoft UC One Communicator Mobile Softphone application that is 
available on the User’s mobile phone to allow them to make and receive calls, and manage their 
telephony features. The Mobile App is supported on different Operating Systems, such as Google 
Android and Apple IOS. 
 
Where do you download it? 
You can download the App via Google Play (for Android) or AppStore (for iPhone) on your mobile. 
You can find information about the App in the Client Downloads section of this document. 
 
How do you use it? 
Click on the UC One Communicator icon on your mobile and login. Your login details will be sent in 
an email with your BizPhone Service Completion Advice.  
 
When you launch the App, it will ask you for login URL. Please enter 
https://apps.bizphone.tpgtelecom.com.au to the login URL and click “OK” to continue to the 
application.  
 
Then enter your login details (username and password) and click “Sign in”. After sign in, you can 
start using your Mobile App. 
 

https://apps.bizphone.tpgtelecom.com.au/
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Note: The login username is case sensitive. Your login username will start with a “U” which must be 
entered as uppercase. 
 

 
UC One Communicator Mobile App 

 
Please refer to the Business Communicator User Guide Android and Business Communicator User 
Guide iPhone for the BizPhone Mobile App user manual. 
 

 

BizPhone Receptionist App 
BizPhone Receptionist App is the Broadworks Attendant console that manages call distribution 
for front desk operator through a web based application. 
 
There are two types of Receptionist App available as part of the iiNet BizPhone product: 

• Receptionist App – Basic 

• Receptionist App – Advanced 
 
Receptionist App Basic 
The Receptionist App Basic enables the receptionist to monitor up to 30 static phone users and have 
a very limited set of features. The administrator will need to login to define the list of monitored 
users via the Admin Portal (Refer to Receptionist section). 
 
Receptionist App Advanced 
The Receptionist App Advanced enables the receptionist to monitor up to 200 static phone users 
with an enhanced interface that has a rich set of features including monitoring, manipulating and 
distributing queued calls (if Call Queuing is activated), and may other call control features. The 
receptionist can use the Receptionist App to define and customise the list of monitored users. 
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You will be able to upgrade from one type to another. By upgrading or changing your Reception 
App type, it will re-provision your Receptionist service and subsequently delete all your 
monitored static contacts. You will need to re-add the contacts once the new service is activated. 
 
 

Minimum System Requirements 
BizPhone Receptionist App needs to be run on specific Operating Systems and certain browsers. The 
following are the Operating System, Browser and Java requirement for the Receptionist App. 
 

Requirements  Details 

Operating System 
Windows XP with SP3 (or higher), Windows Vista, Windows 7, Windows 
8, Mac OS X 10.5 or 10.6, or Citrix XenApp 4 or 5 

Browser 
Internet Explorer 8.0, 9.0 or 10.0; Firefox 17 or later; Google Chrome 
17.0.963.64 or later; or Safari 5 or 6 

Java Java 1.6.0_19 or higher 
 

How do you use it? 
The Receptionist console is a web-based application and accessible via the following URL: 
https://apps.bizphone.tpgtelecom.com.au/receptionistconsole/  
 
Your login details will be sent with your BizPhone Service Completion Advice.  
 
Note: The username is case sensitive. Your login username will start with a “U” which will must be 
entered as an uppercase. 
 
Please refer to the Receptionist User Guide for the user manual and full list of supported features on 
the Receptionist App. 
 

 
Broadworks Receptionist App 

  

https://apps.bizphone.tpgtelecom.com.au/receptionistconsole/
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User Password and Passcode Specifications 
 
User Password Specifications 
 

• Cannot contain the Login ID 

• Cannot be the reverse of the old Password 

• Cannot be any of the last 5 Passwords 

• Must contain at least 2 numbers 

• Must contain at least 2 uppercase alpha characters 

• Must contain at least 2 lowercase alpha characters 

• Must be at least 12 characters 
 
Password Reset 
When a Password Reset is requested through Frontier, users will be emailed a password reset link 
with a lifespan of 1 hour rather than a new randomly generated password. 
 
Voice Portal Passcode Specifications 
 

• Cannot be the user’s own extension or phone number 

• Cannot be the user’s own extension or phone number reversed 

• Cannot contain 3 or more repeated digits 

• Cannot be any of the last 3 Passcode(s) 

• Cannot be the reversed old Passcode 

• Must be at least 6 characters; no more than 8 characters 
 
 

Audio File Specifications 
 

Audio File Format Specifications 

For .WAV files 
• 8.000 or 16.000 kHz 

• 8 or 16 bit mono 

• U law, A-law, or PCM 

For .WMA files 
• 8.000 or 16.000 kHz 

• 16 bit mono 

• U law, A-law, or PCM 

For both .WAV 
files and .WMA 
files 

• The maximum audio length is 2 minutes for a Voice 
Messaging Greeting and Custom Ringback User/Group. 

• The maximum audio length is 10 seconds for user’s Voice 
Portal Personalised Name. 

• The maximum audio length is 10 minutes for the Music On 
Hold greeting. 

• For all other services, the maximum audio length is 5 
minutes. 

 
 
 
 
 



 

    P a g e | 97 
 

Public 

 
 

Recording .WAV or .WMA files 
 
You can use the below procedure to record a personal greeting or an announcement using a PC. 
The Application Server accepts .WAV and .WMA file formats. The section Audio File Specifications 
lists the full list of validation rules for the file formats. 
 
The following table describes the procedure to record a .WAV file. Instructions are provided for the 
following sound recorders: 
 

• Windows XP Sound Recorder and Windows 98 Sound Recorder. 

• Windows 2000 Sound Recorder. 

• Windows NT Sound Recorder. 

• Audacity on Windows 7 and Windows Vista. 
 

Recording with Windows XP or Windows 98 Sound Recorder 
1. In Windows 98, select Start → Programs → Accessories → Entertainment → Sound 

Recorder from the Windows task bar. In Windows XP, select Start → All Programs → 
Accessories → Entertainment → Sound Recorder. 
NOTE: It is possible that your Sound Recorder is located in a different file, or that your 
default sound recorder is another product. Please note the required format for your 
greetings below and follow the instructions for your specific sound recording product. 

2. Make the setting selections. Click Properties from the File menu. The properties for 
Sound window appears. 

3. Click Convert Now and then click OK. The Sound Selection window appears. 
4. Select PCM from the Format list. 
5. Select 16.000 kHz, 16 bit Mono, under Attributes, and click OK. You may want to save this 

format at this point, so that you can easily select it in future. 
6. In the Properties for Sound dialog box, click OK. 
7. Click Record on the Sound Recorder. Speaking clearly into your PC microphone, record 

your message. When you have finished, click Stop. To listen to your message, click Play. If 
you are not pleased with your message, record it again. 

8. When you are satisfied with your message, select Save As from the File menu. Name your 
sound file, being certain that you remember its location and that the file type is a .WAV 
file. 

9. In the File name field, enter the desired name of your recording. 
10. Click OK. To exit without saving, click Cancel. 

 

 
Recording with Windows 2000 Sound Recorder 

1. Select Start → Programs → Accessories → Multimedia → Sound Recorder from the 
Windows task bar. 
NOTE: It is possible that your Sound Recorder is located in a different file, or that your 
default sound recorder is another product. Please note the required format for your 
greetings below and follow the instructions for your specific sound recording product. 

2. Click Record on the Sound Recorder. Speaking clearly into your PC microphone, record 
your message. When you have finished, click Stop. To listen to your message, click Play. If 
you are not pleased with your message, record it again. 

3. Click OK. 
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4. Click Change to modify the settings. Select PCM from the Format list. Select 16.000 kHz, 
16 bit Mono under Attributes, and click OK. You may want to save this format at this 
point, so that you can easily select it in the future. In the Properties for Sound dialog box, 
click OK. 

5. When you are satisfied with your message, select Save As from the File menu. Name your 
sound file as .WAV file type. 

6. In the File name field, enter the desired name of your recording. 
7. Click OK. To exit without saving, click Cancel. 

 

Recording with Windows NT Sound Recorder 
1. Select Start → Programs → Accessories → Multimedia → Sound Recorder from the 

Windows task bar. 
2. Select Audio Properties from the Edit menu. Click the Customize button under Preferred 

quality. The Customize dialog box appears. 
3. From the Format list, click the drop-down arrow to select PCM. 
4. Under Attributes, click the drop-down arrow to select 16.000 kHz, 16 bit Mono. You may 

want to save this format at this point, so that you can easily select it in the future. 
5. Click OK in the Customize dialog. Then click OK in the Audio Properties dialog box. 
6. Click Record on the Sound Recorder. Speaking clearly into your PC microphone, record 

your message. When you have finished, click Stop. To listen to your message, click Play. If 
you are not pleased with your message, record it again. 

7. Click OK. 
8. When you are satisfied with your message, select Save As from the File menu. Name your 

sound file as .WAV file type. 
9. In the File name field, enter the desired name of your recording. 
10. Click OK. To exit without saving, click Cancel. 

 
 

Recording with 7 - 64 bit or Windows Vista using Audacity 
 (Works with version 1.3.12 Beta) 
 
NOTE: Using the built-in Sound Recorder from Windows 7 or Windows Vista does not work as it is 
not possible to control the output format. The output format defaults to .WMA (44.1kHz 96 kBps) 
encoding – a format that is not compatible with the Media Server. 
 

1. Select Start → All Programs → Audacity from the Windows task bar. 
2. Set the default sample rate for recording: 

a. From the Edit menu, select Preferences. 
b. Click the Quality tab. 
c. Select 16000 Hz for the Default Sample Rate. Select 16 bits from the Default Sample 

Format. 
3. Set the number of channels for recording: 

a. Click the Devices tab. 
b. For Channels, select 1 (Mono). 

4. Click OK to exit the Preferences pop up. 
5. Click Record (the round red button at the top). 
6. Record your message. 
7. When you have finished, click Stop (the yellow square button). 
8. To listen to your message, click Play (the green arrow at the top). If you are not pleased with 

your message, record it again. 
9. When you are satisfied with your message, from the File menu, select Export. 
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10. Select Save As Type WAV (Microsoft) signed 16 bit PCM. Name your sound file as a .WAV file 
type. 

11. In the File name field, enter the desired name of your recording. 
12. Click OK. To exit without saving, click Cancel. 

 

Converting .WAV files to .WMA 
 
There are a range of online conversion tools you can use to convert a .WAV file to .WMA format. 
One example is http://audio.online-convert.com/convert-to-wav 
 
Alternatively, to generate a .WMA file, first generate a .WAV file using the instructions for your 
relevant Sound Recorder above. Then, invoke ffmpeg to convert the .WAV file to a .WMA file. For 
example, to convert recording.wav to newrecording.wma, invoke: 
 
ffmpeg –i recording.wav –acodec copy newrecording.wma 

 
 
 
 
 
 
 
 
 
 

http://audio.online-convert.com/convert-to-wav

